Fudaa-LSPIV Version 1.6.4 User Manual

Authors: Magali Jodeau, Alexandre Hauet, Jérôme Le Coz

Document Version 03/10/2018
# Table des matières

1. **General** .................................................................................................................. 1
   - Why the LSPIV? ........................................................................................................ 1
   - Principles of the LSPIV .......................................................................................... 1
   - Free software Fudaa-LSPIV .................................................................................. 2

2. **Start with Fudaa-LSPIV** ..................................................................................... 3
   - Fudaa-LSPIV Software Installation ...................................................................... 3
   - Languages ............................................................................................................. 3
   - Architecture of the main window ......................................................................... 4

3. **Start a Fudaa-LSPIV study** .................................................................................. 5
   - Prerequisites for starting a Fudaa-LSPIV study .................................................... 5
   - Create a new study ............................................................................................... 5
   - Open an existing study ......................................................................................... 5
   - Architecture of a Fudaa-LSPIV project .................................................................. 6

4. **Management of source images** ........................................................................... 7
   - Import an image sequence .................................................................................. 7
   - Import a video and sequence it ........................................................................... 9

5. **Transformation of the images** ............................................................................ 12
   - Selection of the orthorectification mode ............................................................. 12
   - Scaling .................................................................................................................. 12
     - Defining the resolution ....................................................................................... 13
     - Change of real coordinate reference ................................................................ 14
     - Definition of the orthoimage corners and water level ..................................... 15
   - Complete orthorectification .................................................................................. 15
     - Principle of orthorectification .......................................................................... 15
     - Positioning of reference points ....................................................................... 16
     - Verification of the GRP ..................................................................................... 17
     - Transformation parameters ............................................................................. 17
   - Transformation of all the images ......................................................................... 18

6. **Calculation of the tracers velocities** .................................................................... 19
   - Principles .............................................................................................................. 19
   - Parameters of displacement calculation ............................................................ 19
   - Calculation grid ................................................................................................... 21
   - Calculation of the movement velocities of the tracers ....................................... 22

7. **Postprocessing of calculated velocities** ............................................................... 23
   - Filtering instant results ...................................................................................... 23
Averaging the results ........................................................................................................ 24

8. Viewing velocity results .............................................................................................. 25
   Description of result layers for velocity calculations ................................................. 25
   Layer Res. vel ............................................................................................................. 25

9. Calculation of the discharge ...................................................................................... 28
   Fill in the bathymetry of one or more transects ..................................................... 28
   Transects parameters ............................................................................................... 29
   Discharge calculation ............................................................................................... 30
   Export the gauging report ......................................................................................... 31

10. Exporting data ........................................................................................................ 34

11. Known bug and solutions ...................................................................................... 35
   The gauging report is not created ........................................................................ 35

12. Insights .................................................................................................................. 36
   Principle of orthorectification ............................................................................ 36

13. Approfondissements .............................................................................................. 38
   Principe de l’orthorectification ............................................................................... 38
   Le modèle sténopé et sa résolution : cas général 3D ........................................... 38
   Le modèle sténopé et sa résolution : cas particulier 2D ....................................... 39
   Création des orthoimages ..................................................................................... 39

14. References ................................................................................................................ 48
1. General

Why the LSPIV?

The scientist studying rivers under aspects of liquid flow or sediment flow often encounters a mismatch between available hydrometric measurements and needs. These needs have evolved, in parallel with the development of numerical modeling, towards a demand for spatialised data, with a high temporal frequency, and for various flow conditions. In particular, the measurement of velocity and streamflow during floods is often impossible with traditional gauging techniques (current meters, ADCP, tracer dilution), when high velocities and numerous floating debris endanger operators and equipment. In addition, the measurement time inherent to these techniques is often inadequate with the unsteady nature of the flood flows. The development of 2D or 3D modeling tools for the understanding of flows, in the natural environment and in the laboratory physical model, requires, for validation, other measurements in addition to water levels or flow rates. The spatialised velocity results of these models require a corresponding hydrometric measurement, that is to say a velocity field. Again, traditional velocity measurement techniques do not fully meet these needs.

Hydrometry by image sequence analysis is an interesting alternative that allows access to the measurement of instantaneous surface velocities on surfaces up to the hectare, in a non-intrusive way. The technique is called Large Scale Particle Image Velocimetry (LSPIV). For a detailed description of the method, one can refer for example to the thesis of A. Hauet (2006).

Principles of the LSPIV

The analysis of image sequences makes it possible to measure the 2D field of velocity on the surface of a flow provided that visible tracers, such as solid particles (plant debris, small floats, etc.), bubbles or turbulence patterns are advected with the flow, while remaining recognizable from one image to another. This technique is derived from the Particle Image Velocimetry (PIV) used in the laboratory, but for a study on large river-scale objects, hence the name Large-Scale PIV (LSPIV, Fujita et al., 1998). An LSPIV measure comprises (i) recording a sequence of timestamped images of the flow, (ii) a geometric correction of the images to overcome perspective distortion effects (orthorectification) and (iii) a calculation displacement of the tracers of the flow through a statistical correlation of the reasons. In practice, the seeding of the flow by adding tracers is often not necessary for flooded rivers: if the movement of the water is visible in a sequence of images, in general it will be possible to extract the velocities. This gives a "nearly instantaneous" 2D field (at the sampling frequency of the image pairs, limited by the acquisition frequency of the camera and the amplitude of the movements). Knowing the bathymetry of a cross section and assuming a model of vertical velocity distribution, one can arrive at the estimation of the flow rate from the LSPIV velocity field.

The LSPIV has been used to estimate river flows of very different scales, from low to high floods (see, for example, Creutin et al., 2003, Hauet et al., 2008 or Jodeau et al., 2008) and for improvement. calibration curves in normal hydraulic regimes (Le Coz et al., 2010 or Dramais et al., 2011). The LSPIV has also been applied to flood films shared by the public on the internet (Le Boursicaud et al 2016, Le Coz et al 2016). A review of LSPIV applications for streamflow estimation has been proposed by Muste et al. (2008). LSPIV has also been used to study the dynamics of complex flows (Le Coz et al 2010b, Hauet et al., 2009) as well as debris flows (Theule et al., 2018) and physical models of mobile bottom laboratories (Piton et al., 2018). The LSPIV has also proved to be an effective tool for the study of runoff.
runoff (North et al., 2009, Legout et al 2012) where intrusive instruments can not be used because of the very weak tie rods. water considered (millimeters).

**Free software Fudaa-LSPIV**

*Fudaa-LSPIV* is a software for processing flow image sequences to calculate surface velocity fields and flow rates across cross sections. The method is based on the Large-Scale Particle Image Velocimetry (LSPIV) technique, with the following main steps:

- **Source images:** import a sequence of images or sampled images from a video clip
- **Orthorectification:** Correct images from perspective distortion and assign a metric size to pixels
- **PIV analysis:** calculate surface velocities from statistical analysis of tracer movement
- **Post-processing:** apply filters to the velocity results, calculate the time average, calculate the streamlines
- **Discharge:** calculate discharge through a bathymetric transect using a velocity correction coefficient

The *Fudaa-LSPIV* software is a Java interface that calls Fortran executables. The development of *Fudaa-LSPIV* has been executed by DeltaCAD since August 2010 with financing and under the direction of EDF and Irstea. This development is part of the Fudaa free software project for hydraulic applications. The supported languages are French and English and the software can be used with Windows or Linux operating systems. The conditions of diffusion are those of free GPL licenses, and the software is the intellectual property of EDF and Irstea.
2. Start with Fudaa-LSPIV

Fudaa-LSPIV Software Installation

The Fudaa-LSPIV software installation file is available in the following software development forge: https://forge.irstea.fr/projects/fudaa-lspiv/

The installation file is a java .jar file named fudaa-lspiv-xxx-setup.jar, where xxx is the version number. Start the installer (double-click) and follow the procedure. The software installs in the chosen directory, with the following architecture:

- **bin** folder: contains the executable fudaa-lspiv.bat, which is used to launch the application;
- **doc** folder: Contains this User Guide;
- **examples** folder: contains an example of a Fudaa-LSPIV project;
- **exes** folder: contains the Fortran executables called for the LSPIV analysis steps;
- **icons** folder: contains the icons;
- **lib** folder: contains the Java libraries required for the Fudaa-LSPIV application;
- **templates** folder: contains the Excel template for the streamgauging report export;
- **uninstaller** folder: contains the uninstall executable.

Languages

The default language of the Fudaa-LSPIV software is French or English depending on the choice made during the installation. It is possible to switch to English thanks to the Edit → Preferences menu. In the Accessibility → Language tab choose English [en], then restart the software.
Architecture of the main window

The **Fudaa-LSPIV** software consists of 5 panels as described in the figure below:

- The **menus** (panel 1 in the figure) to access the creation or opening of files, or the launch of LSPIV treatments.
- The **quick access bar** (panel 2 in the figure) allowing shortcuts to the main functions of the menus.
- The **graphical toolbar** (panel 3 in the figure) allowing selections and modifications on the graphic display of the views.
- The **layers** (panel 4 in the figure) showing the different layers available and allowing them to be selected or deselected.
- The **graphic display of the views** (panel 5 in the figure) allowing to visualize the source or orthorectified images as well as the results of the calculations.

**Important!**

**Fudaa-LSPIV** works on a logic of layers (like a GIS software for example): to work on a data, an image or a result or to modify the display of a data, an image or a result, you must first select the layer considered.
3. Start a Fudaa-LSPIV study

Prerequisites for starting a Fudaa-LSPIV study
Before starting a Fudaa-LSPIV study, you must have the necessary input data:

- Images of a flow, in the form of a video or sequence of images (all images in the sequence must be spaced by the same time interval, and this time interval must be known precisely). The taking of images must be done without movement. If spurious movements affect the images, it will be useful to align the images using external software, like Fiji for example.
- When acquiring the films, care must be taken with regard to the possible reflections, the good visibility of the tracers and the good distribution of the tracers in the image. When the flow does not have patterns naturally, clearly visible tracers can be added. However, it must be ensured that they move well at the velocity of flow.
- A geometric description of the image area, such as visible reference points on the images and known real coordinates, or scaling elements, to drive orthorectification.
- For discharge measurement applications, reference may be made to the imaging requirements made during the FloodScale project or by the USGS.

Create a new study

To create a new study, click on the Create icon in the quick access bar.

Otherwise, follow the File → Create menu. The corresponding keyboard shortcut is Ctrl + N

Open an existing study

To open an existing study, click the Open icon in the quick access bar.

Otherwise, follow the File → Open menu. The corresponding keyboard shortcut is Ctrl + O. The File → Reopen menu allows you to search for one of the last saved studies.
Architecture of a Fudaa-LSPIV project

_Fudaa-LSPIV_ projects are saved by the _File ➔ Save_ menu as an extension file `.lspiv.zip`. The architecture of a _Fudaa-LSPIV_ project is composed of:

- **img_pgm** folder: contains source images in .pgm format used for processing;
- **img_transf** folder: contains a cache folder of orthorectified images in .gif format, less large in size (optimization of the display); orthorectified images in .pgm format are not saved (.pgm files are empty).
- **outputs.dir** folder: contains the calculation files and LSPIV parameters;
- transects file: contains the projected and interpolated bathymetric transects data;
- **vel_filter** folder: contains the results files of the filtered instantaneous LSPIV velocities, in image coordinates;
- **vel_raw** folder: contains raw instantaneous LSPIV velocity results files, in image coordinates;
- **vel_real** folder: contains the results files of the filtered instantaneous LSPIV velocities, in real coordinates;
- **vel_scal** folder: contains the scalar result files (velocity norm, correlation) computed from filtered instantaneous LSPIV velocities, in real coordinates.
4. Management of source images

The calculations performed in Fudaa-LSPIV are performed on consecutive image sequences with a known and fixed time interval. The user can:

- Import an image sequence
- Import a video and sequence it in Fudaa-LSPIV

Import an image sequence

The **Images → Source Image Management** menu opens the image management window. The **Add** button launches an explorer to select the sequence of images to be analyzed. All standard image formats are managed (png, tif, pgm, jpg, tiff, jpeg, gif, bmp ...). The selected images appear in the image management window.

![Image Management Window](image)

The **Add** button allows you to add new images of the same sequence. The **Remove** button allows you to remove one or more selected images. The **Up** and **Down** buttons change the order of the images in the sequence.

The user here specifies either the **time interval** between two images or the **number of frames per second**.

Once the selection is validated, the images are displayed in the **Source Image Space**.
The source images can be viewed with the scroll list:

Among the images thus imported, some may be used only for the orthorectification step (check the background box) or only for the velocity calculation.
Import a video and sequence it

The *Images ➔ Import images from video* menu opens the window for importing videos.

The **button launches an explorer to select the video to be sequenced. All standard video formats are managed (avi, mov, mpeg ...). The number of frames per second of the movie is displayed as well as the corresponding time interval in seconds.

In the **Sampling** area, enter the sequencing parameters of the video:

- The **number of images** to keep: keep 1 image every N images
- Or the **time interval** between two images. This number must be greater than the original time interval.
- If the entire video is not to be analyzed, enter the start and end time of the sequence of interest, in seconds.

By validating, we start the sequencing. The png image sequence can be displayed in the image management window.
The **Add** button allows you to add new images of the same sequence. The **Remove** button allows you to remove one or more selected images. The **Up** and **Down** buttons change the order of the images in the sequence.

Once the selection is validated, the images are displayed in the **Source Image Space**.

The source images can be viewed with the scroll list:
Among the images thus imported, some may be used only for the orthorectification step (check the background box) or only for the velocity calculation.
5. Transformation of the images

Selection of the orthorectification mode

*Fudaa-LSPIV* offers two modes of orthorectification:

- **Scaling**: when images are not distorted by perspective effects (vertical viewpoint with no lens distortion), a simple scaling in metres per pixel can be sufficient;
- **Complete Orthorectification**: when images are distorted by perspective effects, a complete orthorectification based on reference points must be done.

These modes can be accessed via the *Orthorectification → Orthorectification Mode* menu.

These two modes of image transformation allow for a 2D or 3D orthorectification, or a simple scaling of the pixels of the image. These three types of transformation and their requirements are summarised in the following diagram and described in the following sections.

**Scaling**

When the point of view of the camera is vertical (seen from the sky), we can often neglect the perspective effects, at least in the centre of the image. Orthorectification of the images is not necessary. Scaling simply consists of specifying the physical size of a pixel. The *Orthorectification → Scaling → Parameters* menu brings up the window for setting the scaling parameters:
Defining the resolution

In the **Resolution** tab, three methods are proposed to specify the resolution of the images (the physical size of the pixels in metres):

- Direct input of the resolution if it is known: enter the resolution in m/pix in the dedicated box.

- Entering pairs of points defining segments of known size: click on the positions of the ends of the first segment in the image; the image coordinates \((I_1, J_1)\) and \((I_2, J_2)\) of the two points then appear in the array; indicate opposite the length of the segment (distance between the two points) in metres; the corresponding resolution is calculated. You can re-iterate the operation for as many segments of known size. The average of the resolutions thus calculated is displayed and will be the one used for the image transformation.

- Alternatively, the real-world coordinates of the ends of the segments can be filled in, instead of the lengths of the segments. Select **Coordinates** instead of **Distance** from the drop-down menu.
Change of real coordinate reference

The Transformation tab is used to define the translation/rotation parameters that can be applied to the actual orthoimage reference. This is particularly useful if the velocity field is to be compared to other data, or if a bathymetric transect measured in this particular reference is then used for the calculation of the discharge.

By default, the option "no translation/rotation" is selected and no reference change will be applied. The lower left corner of the image is the origin of coordinates (0,0) and the X and Y axes are the horizontal and vertical axes of the original image.

Otherwise, it is possible to define the change of reference to be applied by entering the real coordinates (X1,Y1) and (X2,Y2) of two points previously positioned (by clicking) in the image: their image coordinates (I1,J1) and (I2,J2) are displayed in the table.
Definition of the orthoimage corners and water level

The **Others** tab allows you to define the coordinates of the corners of the orthoimage: it is simply a sub-selection (crop) of the original image. The proposed **Default values** are the positions of the left-bottom and top-right corners of the total image, calculated by multiplying the image dimensions (in pixels) by the previously calculated resolution (in m/pix). This amounts to keeping all the original images for the transformation.

It is also possible to enter in this **Others** tab the water level (in m) that will not be used for the transformation of the images or for the calculation of velocities but will be used for the calculation of discharge.

The **Apply** button runs the transformation of the first image using the specified parameters, in order to get an idea of the result. The **Validate** button saves the scaling parameters, displays the first transformed image and allows you to proceed to the next step (Transform all images).

**Complete orthorectification**

**Principle of orthorectification**

Orthorectification consists of creating a corrected image of the perspective and scaling effects of the real world for a given plane. Full details on the [Principles of Orthorectification page](#).
Positioning of reference points

Two methods are possible for positioning reference points:

- The Orthorectification → Orthorectification → Reference Points → New ones menu brings you to the GUI for positioning reference points. Enter the terrain coordinates \((\text{real } X, \text{real } Y)\) and \((\text{real } Z)\) of the first point, then click on the pixel of the image locating the GRP, the image coordinates \(I\) and \(J\) are then filled. It is possible to zoom to better see a point. Repeat the operation for all reference points (at least 4 for 2D orthorectification, at least 6 for 3D orthorectification, see the orthorectification principles for more details). The Input finished button closes the operation and creates a file in the project architecture outputs.dir\GRP.dat.

- The Orthorectification → Orthorectification → Reference points → Import menu allows you to load a GRP.dat file. This file must be a text file, with the following format:
  - The first line contains only the text “GRP”
  - The second line is an integer specifying the number of reference points used
  - The third line contains the titles of the data: \(X\ Y\ Z\ i\ j\); let \(X, Y, Z\) be the field coordinates of the points and \(i, j\) the image coordinates of the points.
  - The following lines are the data.

It is important to note that the reference points must be entered in metric units (this defines the units for further processing).
Verification of the GRP

The Orthorectification → Orthorectification → Verification of the reference points menu makes it possible to ensure the quality of the correspondence of the GRP field and image coordinates. The orthorectification matrix (see Principles of orthorectification) is calculated, and the land position (X, Y and Z) of the landmarks is calculated from their image coordinates (I and J). The true terrain coordinates and the calculated terrain coordinates are then compared. The distance between these true and calculated coordinates, called Gaps, is presented in a table and graphically.

Transformation parameters

There are two methods for entering transformation parameters:

- The Orthorectification → Orthorectification → Transformation Parameters → Define menu opens the Transformation Parameters management window. The study area is defined by a rectangle whose position of the corners in the real coordinate system (Xmin, Xmax, Ymin, Ymax) is indicated. This framework makes it possible to reduce the orthorectification to the area of interest and thus limit the calculation times. The resolution, in meters per pixel, corresponds to the size of a pixel in the orthorectified image. The resolution must be adjusted so that the details of the plotters remain visible in the orthoimage, without generating orthoimages of too large sizes (the orthoimage must have approximately the same dimensions as the raw image). The button is used to automatically enter the Xmin, Xmax, Ymin, Ymax and Resolution fields. Finally, the Water Level, in the real reference, must be filled in. The orthoimage will only be valid for this height (see the principles for creating orthoimages). Clicking Apply will produce an orthorectified image. Adjust the setting as necessary, then Validate. The transformation parameters are stored in the outputs.dir\img_ref.dat file.
The Orthorectification ➔ Orthorectification ➔ Transformation parameters ➔ Import menu allows you to load the orthorectification parameters of an existing study using an img_ref.dat file. This file has the following format:

Transformation of all the images

The Orthorectification ➔ Transform images menu starts the orthorectification of all selected images. Orthorectified images are stored in the img_transf folder.

The cache folder contains the same .gif images, which are smaller in size.
6. Calculation of the tracers velocities

Principles

LSPIV uses a cross correlation statistical method on orthorectified images to determine the displacement of tracers visible on the surface. The principles are detailed on the Principles of tracer velocity measurement.

Parameters of displacement calculation

Two methods are possible to define the parameters of the tracer displacement calculation:

- The LSPIV Analysis → Calculation parameters → Define menu launches the interface for the tracer motion Calculation Parameters. Several parameters are to be entered:

  - the Interrogation Area (IA) size, in meters or in pixels (linked units), see the Principles of tracer velocity measurement for details. This area must be large enough to incorporate tracers, but small enough to be representative of the flow (velocity gradients in an IA must be negligible). As a good practice, it should be noted that the IA must have a metric size in adequacy with the size of the tracers to follow and the scale characteristic of the measured flow, while keeping a sufficiently small size to allow a calculation in a reasonable time. A size of about 30 pixels is preferred (the size must be an even number). The Apply button allows a graphic display of the size of the IA on an orthorectified image. The user can choose the location of the center of the window by entering their coordinates in Center position or by clicking on a pixel in the image after activating the Position button.
  - the Search Area (SA) size in meters or pixels (linked units), see the Principles of Tracer Velocity Measurement page for more details. The search area is a rectangle defined around the center of the interrogation area. It corresponds to the zone in which the patterns are searched on the successive images. When the flow has a preferred direction, the search area can be extended in this direction. The SA is defined by 4
parameters, Sim, Sip, Sjm and Sjp. The **Apply** button allows a graphical visualization of the size of the SA on an orthorectified image.

- The parameters of the calculation of the tracer movements are stored in the file `outputs.dir\PIV_param.dat` during the validation.

- **The LSPIV Analysis \rightarrow Calculation Parameters \rightarrow Import** menu allows you to load the calculation parameters of the displacements of an existing study thanks to a file `PIV_param.dat`. This file has the following format:
Calculation grid
The calculation grid represents all the points for which a velocity will be calculated, see the Principles of tracer velocity measurement for more details. Two methods are possible to define the calculation grid:

- The LSPIV Analysis → Grid points → Define menu launches the interface for the Grid outline. The outline of the grid is a quadrilateral defined by its four corners thanks to clicks on the orthoimage. The density of the grid is defined by a spacing pitch on the opposite segments of the quadrilateral. The Apply button allows a graphical display of the grid on the orthoimage. The calculation grid is stored in the outputs.dir\grid.dat file and the grid parameters are stored in the outputs.dir\grid_param.dat file during validation.

- The LSPIV Analysis → Grid Points → Import menu allows you to load a grid from an existing study using a grid.dat file. This text file is a list of the I, J coordinates of all the grid nodes in the orthoimage frame.
Calculation of the movement velocities of the tracers

The LSPIV analysis → Calculation of instantaneous results menu launches the statistical analysis of plotter displacements for all image pairs in the sequence. See the Principles of Measuring Tracer Movement Velocity for more details. An "instantaneous" velocity field (at the step of the time interval between two images) is obtained for all consecutive image pairs. Thus, for N selected images, we obtain N-1 velocity fields, stored in the vel_raw folder.

The layer group Raw inst. surf. vel. (for raw instantaneous surface velocities) is created.

It allows to visualize the calculated velocities for the image pairs in the form of a vector field (Raw inst. res. vel.), streamlines (Raw inst. res. part., see how to compute it here) or isocontours (Raw inst. res. iso.). More details on the visualization and setting of velocity layers here. The graphical interface makes it possible to link the visualization of the images and velocities calculated thanks to the button to Link/Unlink the images and the velocities.
7. Postprocessing of calculated velocities

The post-processing step includes filtering and averaging the velocity results.

Filtering instant results

The Post-Processing → Instantaneous results filtering menu launches the filtering interface. Two tabs are available:

- The **Velocity** tab allows you to filter on standard values or Vx or Vy components. To use this filter, select the Filter velocities check box and enter the minimum and maximum values for the different filters. By default, the minimum velocity threshold is set to a value corresponding to 2 pixels of displacement.

- The **Correlation** tab allows the calculated velocities to be kept within a certain range of correlation values, see the Tracer Motion Velocity Measurement Principles page for more details. To use this filter, select the Filter correlations check box and enter the minimum and maximum values for the correlation range for which the velocities are to be maintained. The minimum value depends on the quality of the tracers and their temporal conservation. For non-deformable tracers (hard objects, artificial tracers) high correlations (of the order of 0.7) may be required. For deforming tracers (turbulence figures, foam), we will ask for a lower minimum threshold (of the order of 0.4). By fixing a maximum bound at 0.98, we will avoid artifices if the calculation grid overflows the flow and encroaches on static areas (bank, edge image). The default correlation thresholds are set as 0.4 (min) and 0.98 (max).

Filtered instant velocity fields are stored in the vel_filter folder. The layer group Filtered inst. surf. vel. (for filtered instantaneous surface velocities) is created.
It makes it possible to visualize the calculated velocities for the image pairs in the form of a vector field \((\text{Filt. inst. res. vel.})\), Of lines of current \((\text{Filt. inst. res. part.})\), see how to calculate it \(\text{here}\) (see how to calculate it here) or isocontours \((\text{Filt. inst. res. iso.})\) More details on the visualization and the parameterization of the velocity layers \(\text{here}\). The graphical interface makes it possible to link the visualization of the images and velocities calculated thanks to the button to \(\text{Link/Unlink}\) the images and the velocities.

Averaging the results

The \(\text{Post-Processing} \rightarrow \text{Filtered average instantaneous results}\) menu launches the average field calculation interface.

We select the filtered velocity fields to be averaged (a priori, all the filtered results are selected) and the validation button is used to calculate the averaged velocity field on all the image pairs of the sequence.

The averaged velocity field is stored in the file \(\text{outputs.dir/average_vel.out}\). The layer group \(\text{Average surf. vel.}\) (for averaged surface velocities) is created.

It makes it possible to visualize the calculated velocities for the image pairs in the form of a vector field \((\text{Average res. vel.})\), Of lines of current \((\text{Average res. part.})\), see how to calculate it \(\text{here}\) (see how to calculate it here) or isocontours \((\text{Average res. iso.})\) More details on the visualization and the parameterization of the velocity layers \(\text{here}\). The graphical interface makes it possible to link the visualization of the images and velocities calculated thanks to the button to \(\text{Link/Unlink}\) the images and the velocities.
8. Viewing velocity results

Description of result layers for velocity calculations

During each velocity calculation stage (instantaneous, filtered and averaged velocities), a specific layer group is created. This group systematically includes 3 types of layers:

- Res. vel. layers
- Res. part layers
- Res. iso layers

Layer Res. vel.

This layer allows the visualization of results as vectors, as shown below.
The following display options are available through the graph toolbar (be sure to select the layer on which the display options wish to be applied):

- **Configuration** opens the configuration window. This allows
Choix de la couleur des vecteurs
Choix de transparence des vecteurs
Choix de la couleur des vecteurs
Choix de taille relative des vecteurs. Pour la modifier, décocher la case **Légende : utiliser une norme fixe**
Cacher les vecteurs dont la norme est inférieure à **Norme minimale**
Afficher seulement 1/Densité vecteurs
9. Calculation of the discharge

*Fudaa-LSPIV* can calculate a discharge from averaged velocities if one or more known bathymetry transects are filled in, see the Principles of Discharge Calculation page for more details.

**Fill in the bathymetry of one or more transects**

Two methods are possible to fill one or several bathymetries of transects:

- The **Discharge → Transect → New** menu launches the interface to define a bathymetric profile. A profile is indicated on a straight line, preferably perpendicular to the discharge. First, enter the Z coordinate in the real coordinate system of the edge on the left bank of the transect, then click on the corresponding point in the orthorectified image. Repeat for all points of the bathymetric transect. The first two points indicated define the orientation of the bathymetric profile. The bathymetric profiles are stored in `outputs.dir/bathy_p.dat`.

- The **Discharge → Transect → Import** menu allows you to load an existing bathymetric profile as an X, Y, Z text file. If the points of this transect are not perfectly aligned on a straight line, they are projected on the right defined by the first and the last point of the transect.
• If the orientation of the transects is not good (right bank and left bank inverted), select the 
  **Transects** layer of the **Discharge** layer group, select the wrong transect(s) with the selection 
  tool 
  : and use the **Edit → Invert transects** menu.

**Transects parameters**
Select the **Transects** layer of the **Discharge** layer group, select the transect (s) to be set with the 
  selection tool 
  , and use the **Discharge → Transect parameters** menu.

• The **Interpolation space step of the bathymetry (m)** interpolates a bathymetric transect that 
  is not sufficiently sampled. Since discharge is calculated using velocities at known bathymetry 
  points (see **Principles of Discharge Calculation**), the transect should have about 20 points in 
  the wet zone. The Z interpolation is done linearly from the neighboring data. The graphic 
  display shows the effect of the interpolation on the orthorectified image.

• The **Velocity searching radius (m)** indicates the area around the known bathymetry point in 
  which the calculated LSPIV velocities (Average Area Velocity) will be averaged to assign a 
  surface velocity value (see **Principles of Discharge Calculation**). The graphic display shows the 
  footprint of the search radii around each bathymetric point.
The **Velocity coefficient** is the ratio of the velocity averaged over the depth to the surface velocity. It makes it possible to calculate a velocity averaged over the depth from the surface velocity assigned to the bathymetric point (see **Principles of discharge calculation**).

**Discharge calculation**

The **Discharge → Calculation of the discharge** menu (shortcut: CTRL+shift+Q) starts the discharge calculation for the bathymetric transects present. For details of the discharge calculation, see **Discharge Calculation Principles**. At the end of the calculation, the results window opens. It allows you to see the calculated parameters for all transects and compare each result to the average of all transects.

The **Discharge → Show calculation results** menu allows you to review the discharge calculation table without restarting the calculation.

The layer **Depth-average vel.** (for depth-average velocities) is created and displayed on the orthoimage. It makes it possible to visualize the averaged velocities on the depth at each bathymetric point.
After selecting the transects of interest, the **Discharge → Transect(s) 3D View** menu allows a 3D visualization of the bathymetry of the transects, the height of water and velocities averaged over the depth.

---

Export the gauging report

The **Discharge → Export gauging report** menu allows you to make a gauging report containing all study parameters and results. Fill in the fields of the dialog concerning information about the place, the date and the realization of the measurement. Also available from the **File → Export → Export gauging report** menu.
After validation, choose the backup directory of the gauging report. The report is an Excel file printable on a double-sided A4.

<table>
<thead>
<tr>
<th>Stage:</th>
<th>-0.05 m</th>
<th>Mean discharge:</th>
<th>42.673 m³/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured by:</td>
<td>-</td>
<td>Measured discharge ratio:</td>
<td>99.6 %</td>
</tr>
<tr>
<td>Computed by:</td>
<td>-</td>
<td>Weather conditions:</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computation date/time:</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image parameters</th>
<th>Camera:</th>
<th>Number of images per second:</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Number of images:</td>
<td>Time interval between images:</td>
<td>0.2 s</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Orthorectification parameters</th>
<th>Number of GRPs:</th>
<th>Xmin: -12.917 m</th>
<th>Xmax: -6.319 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max error on GRP positions:</td>
<td>0.118 m</td>
<td>Ymin: -0.01 m</td>
<td>Ymax: 8.477 m</td>
</tr>
<tr>
<td>Resolution:</td>
<td>0.02 m/pix</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LSPIV parameters</th>
<th>Size of interrogation area:</th>
<th>16 pix</th>
<th>&lt;= 0.32 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size of search area</td>
<td>Sim: 4 pix</td>
<td>&lt;= 0.4 m/s</td>
<td>Sip: 4 pix</td>
</tr>
<tr>
<td></td>
<td>Sjm: 0 pix</td>
<td>&lt;= 0 m/s</td>
<td>Sjp: 25 pix</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filters</th>
<th>Velocity magnitude thresholds:</th>
<th>Min: -</th>
<th>Max: -</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Vx velocity component thresholds:</td>
<td>Min: -</td>
<td>Max: -</td>
</tr>
<tr>
<td></td>
<td>Vy velocity component thresholds:</td>
<td>Min: -</td>
<td>Max: -</td>
</tr>
<tr>
<td></td>
<td>Correlation:</td>
<td>Min: 0.2</td>
<td>Max: 0.8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Discharge computation parameters</th>
<th>Number of transects:</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bathymetry survey date/time:</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Velocity search radius:</td>
<td>Min: 1 m</td>
<td>Max: 1 m</td>
</tr>
<tr>
<td>Interpolation step of discharge</td>
<td>Min: 0.5 m</td>
<td>Max: 0.5 m</td>
</tr>
<tr>
<td>Velocity coefficient:</td>
<td>Min: 0.85</td>
<td>Max: 0.85</td>
</tr>
</tbody>
</table>

Page 1
Project name: Claix.lspiv.zip
Station code: -
Station name: -
Fudaa-LSPIV version: 1.6.4
Measurement number: -
Measurement date/time: -

<table>
<thead>
<tr>
<th>Stage:</th>
<th>-0.05 m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean discharge:</td>
<td>42.673 m³/s</td>
</tr>
</tbody>
</table>

| Measured by: | - |
| Computed by: | - |

| Weather conditions: | - |
| Computation date/time: | - |

### Table of results

<table>
<thead>
<tr>
<th>#</th>
<th>Total Q (m³/s)</th>
<th>Gap (%)</th>
<th>Wetted area (m²)</th>
<th>Gap (%)</th>
<th>Mean velocity (m/s)</th>
<th>Gap (%)</th>
<th>Measured Q (m³/s)</th>
<th>Measured Q / Total Q (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>45.87</td>
<td>+7.5</td>
<td>41.645</td>
<td>+0.1</td>
<td>1.101</td>
<td>+7.4</td>
<td>45.666</td>
<td>99.6</td>
</tr>
<tr>
<td>2</td>
<td>41.107</td>
<td>-3.7</td>
<td>41.725</td>
<td>+0.3</td>
<td>0.985</td>
<td>-4.0</td>
<td>41.008</td>
<td>99.8</td>
</tr>
<tr>
<td>3</td>
<td>41.041</td>
<td>-3.8</td>
<td>41.4</td>
<td>-0.5</td>
<td>0.991</td>
<td>-3.4</td>
<td>40.816</td>
<td>99.5</td>
</tr>
<tr>
<td>Average</td>
<td>42.673</td>
<td>+0.0</td>
<td>41.59</td>
<td>+0.0</td>
<td>1.026</td>
<td>+0.0</td>
<td>42.497</td>
<td>99.6</td>
</tr>
</tbody>
</table>

**Comment:** -
10. Exporting data

Several export formats are possible:

- ASCII files
- Raw and orthorectified images
- Export TELEMAC format (.slf) to be then imported into another software (QGIS, BlueKenue ...)

34
11. Known bug and solutions

The gauging report is not created

At the request of creation of the gauging report, the following message can appear:

The solution is to copy the templates directory from the software installation source directory to the bin directory.
12. Insights

Principle of orthorectification

The pinhole model and its resolution: general 3D case

We consider a pinhole model to move from an object of coordinates $X, Y, Z$ in a real reference to its representation $i, j$ in an image reference. The link between these coordinates can be written in the form called DLT (for Direct Linear Transformation) as:

$$i = \frac{a_1.X + a_2.Y + a_3.Z + a_4}{a_9.X + a_{10}.Y + a_{11}.Z + 1} \quad \text{and} \quad j = \frac{a_5.X + a_6.Y + a_7.Z + a_8}{a_9.X + a_{10}.Y + a_{11}.Z + 1}$$

The coefficients $a_i$ have no physical meaning but are combinations of the intrinsic and extrinsic parameters of the shot. The previous system can be written in matrix form:

$$\begin{bmatrix} X & Y & 0 & 0 \\ Z & 1 & 0 & 0 \end{bmatrix} \begin{bmatrix} a_1 & a_2 & a_3 & a_4 & a_5 & a_6 & a_7 & a_8 & a_9 & a_{10} & a_{11} \end{bmatrix}^{T} = \begin{bmatrix} i \\ j \end{bmatrix}$$

It is possible to solve the equation system above if we are in possession of reference points whose coordinates in the real marks ($X, Y, Z$) and image ($i, j$) are known. These are points visible on the images, and whose real coordinates could be measured in the field.

The equation system above has 11 unknowns (the coefficients $a_i$), and each landmark provides a coordinate $i$ and $j$. At least 6 benchmarks are needed to resolve this system (which will then be overdetermined). The measurement of the real coordinates and the pointing of the image coordinates being tainted with uncertainty, it is advisable to use more than 6 reference points. For a number $N > 6$ of reference points, the following matrices are defined:

$$T = [2N \times 11] = \begin{bmatrix} X_1 & Y_1 & Z_1 & 1 & 0 & 0 & 0 & 0 & -i_1 X_1 & -i_1 Y_1 & -i_1 Z_1 \\ X_2 & Y_2 & Z_2 & 1 & 0 & 0 & 0 & 0 & -i_2 X_2 & -i_2 Y_2 & -i_2 Z_2 \\ \vdots & \vdots & \vdots & \vdots & \vdots & \vdots & \vdots & \vdots & \vdots & \vdots & \vdots \\ x_n & y_n & Z_N & 1 & 0 & 0 & 0 & 0 & -i_N x_n & -i_N y_n & -i_N Z_N \end{bmatrix}^{T}$$

$$A = [11 \times 1] = \begin{bmatrix} a_1 & a_2 & a_3 & a_4 & a_5 & a_6 & a_7 & a_8 & a_9 & a_{10} & a_{11} \end{bmatrix}^{T}$$

$$Z = [2N \times 1] = \begin{bmatrix} i_1 & i_2 & \ldots & i_N & j_1 & j_2 & \ldots & j_N \end{bmatrix}^{T}$$

And the pinhole model is written:

$$TA = Z$$

The system being overdetermined calculating the elements of $A$ is done by a least squares regression.

We search for the solutions of $A$ which minimize the quadratic difference: $||TA-Z||^2$, which amounts to seeking a solution to

$$\left(\frac{\partial ||TA-Z||^2}{\partial A} = 0 \rightarrow 2T \cdot T (TA-Z) = 0 \rightarrow T \cdot T \cdot TA-T \cdot T Z = 0 \right)$$

So we have the following solution for matrix $A$:

$$A = (T \cdot T)^{-1} \cdot T \cdot Z$$

The pinhole model and its resolution: special 2D case

If one tries to represent a 2D scene in the real world, a simplified model can be deduced from the complete model. If we consider that the discharge that we wish to measure is a plane, that all the reference points belong to the plane of the river, and that this plane has a coordinate $Z = 0$ the system of equation (1) writes:

$$i = \frac{(a_1.X + a_2.Y + a_4)}{(a_9.X + a_{10}.Y + 1)} \quad \text{and} \quad j = \frac{(a_5.X + a_6.Y + a_8)}{(a_9.X + a_{10}.Y + 1)}$$

We therefore have a solution with 8 coefficients $a_i$, and the system can be solved with at least 4 reference points.

Creation of orthoimages
An orthoimage represents a corrected view of the perspective and scaling effects of the real world, for a given plane. In the case of LSPIV analyzes, it is desirable to orthoreject the plane of the surface of the discharge (it is therefore assumed that our discharge is plane). This plane can be expressed as a function of X and Y such that \( Z = b_{1}X + b_{2}Y + b_{3} \). Assuming that the longitudinal and transverse slopes are negligible at the scale of the shot, or that the actual coordinate system is expressed relative to the plane of the river (XY plane parallel to the plane of the river), we reduce the equation of the plane to \( Z = b_{3} \), where \( b_{3} \) is the free surface height in the real reference, \( h \).

The system of equation (1) is reduced, in the plane of discharge, to:

\[
i = \frac{(a_{1}.X + a_{2}.Y + a_{3}.h + a_{4})}{(a_{9}.X + a_{10}.Y + a_{11}.h + 1)} \quad j = \frac{(a_{5}.X + a_{6}.Y + a_{7}.h + a_{8})}{(a_{9}.X + a_{10}.Y + a_{11}.h + 1)} \quad (2)
\]

The coefficients \( a_{i} \) were calculated as presented in the previous parts. The method for constructing orthoimages consists of:

1. Define the zone to be imaged in the real coordinate system, i.e., give the coordinates \((X, Y)\) of the 4 corners of the orthoimage (done in the Orthorectification menu).
2. Sample this area with a given resolution in order to create a grid, knowing that each of the nodes of this grid will be the center of a pixel of the orthorectified image.
3. For each node of the grid, with coordinates \((X_i, Y_i)\), the corresponding coordinates in the source image \((i_i, j_i)\) are calculated with equation (2). The coordinates \((i_i, j_i)\) thus calculated are reals and not integers.
4. Each center pixel \((X_i, Y_i)\) is assigned a gray level intensity corresponding to the pixel \((i_i, j_i)\) of the source image. Since the coordinates \((i_i, j_i)\) are real, we use an interpolation on the neighboring pixels to define the intensity in gray level, with a cubic convolution:

\[
f(i_i, j_i) = \sum_{k=-3}^{3} \sum_{l=-3}^{3} [f(i_{i+k}, j_{i+l})C(i_{i+k} - i_i)C(j_{i+l} - j_i)]
\]

Où \( f(i_{i+k}, j_{i+l}) \) est l’intensité du pixel \((i_{i+k}, j_{i+l})\) dans l’image source et \( C \) prend la forme :

\[
C(s) = \begin{cases} 
1 - 2|s|^2 + |s|^3 & \text{si } 0 \leq |s| \leq 1 \\
4 - 8|s| + 5|s|^2 - |s|^3 & \text{si } 1 \leq |s| \leq 2 \\
0 & \text{sinon}
\end{cases}
\]

Où \( s = k \) ou \( l \)
13. Approfondissements

Principe de l’orthorectification

Le modèle sténopé et sa résolution : cas général 3D

On considère un modèle sténopé permettant de passer d’un objet de coordonnées X,Y,Z dans un repère réel à sa représentation i,j dans un repère image. Le lien entre ces coordonnées peut s’écrire sous la forme dite DLT (pour Direct Linear Transformation) comme :

\[
i = \frac{a_1 X + a_2 Y + a_3 Z + a_4}{a_9 X + a_{10} Y + a_{11} Z + 1} \quad \text{et} \quad j = \frac{a_5 X + a_6 Y + a_7 Z + a_8}{a_9 X + a_{10} Y + a_{11} Z + 1}
\]

Les coefficients a, n’ont pas de sens physique mais sont des combinaisons des paramètres intrinsèques et extrinsèques de la prise de vue. Le système précédent peut s’écrire sous forme matricielle :

\[
\begin{bmatrix} X & Y & Z & 1 & 0 & 0 & 0 & 0 & -iX & -iY & -iZ \\ 0 & 0 & 0 & 0 & X & Y & Z & 1 & -jX & -jY & -jZ \end{bmatrix} \cdot \begin{bmatrix} a_1 \\ a_2 \\ a_3 \\ a_4 \\ a_5 \\ a_6 \\ a_7 \\ a_8 \\ a_9 \\ a_{10} \\ a_{11} \end{bmatrix}^T = \begin{bmatrix} i \\ j \end{bmatrix}
\]

Il est possible de résoudre le système d’équation ci-dessus si on est en possession de points de référence dont les coordonnées dans les repères réel (X,Y,Z) et image (i,j) sont connus. Il s’agit de point visibles sur les images, et dont les coordonnées réelles ont pu être mesurées sur le terrain.

Le système d’équation ci-dessus possède 11 inconnues (les coefficients a), et chaque point de repère apporte une coordonnée i et j. Il faut donc a minima 6 points de repère pour résoudre ce système (qui sera dès lors surdéterminé). La mesure des coordonnées réelles et le pointage des coordonnées image étant entaché d’incertitude, il est conseillé d’utiliser plus que 6 points de référence. Pour un nombre N >= 6 de points de référence, on définit les matrices suivantes :
Les coefficients $a_i$ ont été calculés tels que présenté dans les parties précédentes.
La méthode pour construire les orthoimages consiste à :

- Définir la zone à imager dans le repère réel, c'est-à-dire donner les coordonnées (X,Y) des 4 coins de l’orthoimage (fait dans le menu **Orthorectification**) 
- Échantillonner cette zone avec une résolution donnée afin de créer une grille, sachant que chacun des nœuds de cette grille sera le centre d’un pixel de l’image orthorectifiée. 
- Pour chaque nœud de la grille, de coordonnées (X_i,Y_i), on calcule les coordonnées correspondantes dans l’image source (i,j) avec l’équation (2). Les coordonnées (i,j) ainsi calculées sont des réels et non des entiers. 
- On affecte à chaque pixel de centre (X_i,Y_i) une intensité en niveau de gris correspondant au pixel (i,j) de l’image source. Puisque les coordonnées (i,j) sont des réels, on utilise une interpolation sur les pixels voisins pour définir l’intensité en niveau de gris, avec une convolution cubique :

\[
f(i_i, j_i) = \sum_{k=-3}^{3} \sum_{l=-3}^{3} [f(i_{i+k}, j_{i+l})C(i_{i+k} - i_i)C(j_{i+l} - j_i)]
\]

Où \(f(i_{i+k}, j_{i+l})\) est l’intensité du pixel \((i_{i+k}, j_{i+l})\) dans l’image source et \(C\) prend la forme :

\[
C(s) = \begin{cases} 
1 - 2|s|^2 + |s|^3 & \text{si } 0 \leq |s| \leq 1 \\
4 - 8|s| + 5|s|^2 - |s|^3 & \text{si } 1 \leq |s| \leq 2 \\
0 & \text{sinon}
\end{cases}
\]

Où \(s = k\) ou \(l\)
Principles of measuring the velocity of movement of tracers

A cross-correlation statistical analysis is performed on the orthorectified images to determine the displacement of the tracers visible on the surface. Fudaa-LSPIV software uses an optimized algorithm for large-scale spatial applications with low image resolutions. The correlation between an interrogation window (IA for interrogation area) centered on a point \( a_{ij} \) in an image and the same IA centered on a \( b_{ij} \) point in the next image is calculated, images separated by a time interval of \( \Delta t \) seconds. The size of the query window can be set in Fudaa-LSPIV. The correlation coefficient \( R(a_{ij}, b_{ij}) \) is calculated as follows:

\[
R(a_{ij}, b_{ij}) = \frac{\sum_{i=1}^{M_i} \sum_{j=1}^{M_j} [(a_{ij} - \bar{a}_{ij})(b_{ij} - \bar{b}_{ij})]}{\sqrt{\sum_{i=1}^{M_i} \sum_{j=1}^{M_j} (a_{ij} - \bar{a}_{ij})^2 \sum_{i=1}^{M_i} \sum_{j=1}^{M_j} (b_{ij} - \bar{b}_{ij})^2}}
\]

where \( M_i \) and \( M_j \) are the sizes of the interrogation window (in pixels) and \( a_{ij} \) and \( b_{ij} \) are the distributions of the intensities of the pixels in the two interrogation windows. This calculation is performed only for \( b_{ij} \) points included in a search window defined by the user, saving computing time.

It is assumed that the most probable displacement of the discharge from the point \( a_{ij} \) during the time \( \Delta t \) is that corresponding to the correlation maximum, with the possibility of defining a minimal correlation required.

The accuracy of the calculation being at the pixel near, it is interesting to perform a sub-pixel interpolation. Let \( b_i \) be the position of the maximum correlation. In Fudaa-LSPIV, an adjustment of a unidimensional Gaussian law is used on the axes \( i \) and \( j \) to obtain a precision of displacement of the order of 0.2 pixels in the form:

\[
\Delta i = \frac{\ln(b_{(i-1),j}) - \ln(b_{(i+1),j})}{2 \ln(b_{(i-1),j}) -2\ln(b_{(i),j}) + \ln(b_{(i+1),j})} \\
\Delta j = \frac{\ln(b_{(i),j-1}) - \ln(b_{(i),j+1})}{2 \ln(b_{(i),j-1}) -2\ln(b_{(i),j}) + \ln(b_{(i),j+1})}
\]

The sub-pixel position of the correlation maximum is given as \( b_i + \Delta i, j + \Delta j \). Surface velocities are calculated from displacements \( b_i + \Delta i, j + \Delta j - a_i \) divided by \( \Delta t \). The calculation is repeated iteratively over the entire image for each node of the calculation grid. Thus, a surface 2D velocity field "instantaneous" (between two successive images) is calculated. Fudaa-LSPIV makes it possible to apply filters to eliminate the aberrant velocities resulting from the statistical computation. Filters on the minimum value of the correlation coefficient, the amplitude and the orientation of the velocities are implemented in the software. Finally, Fudaa-LSPIV makes it possible to average the filtered instantaneous velocity fields to calculate an averaged velocity field over the duration of the image sequence.

Principes de la mesure de la vitesse de déplacement des traceurs

Une analyse statistique en corrélation croisée est effectuée sur les images orthorectifiées afin de déterminer le déplacement des traceurs visibles en surface. Le logiciel Fudaa-LSPIV utilise un algorithme optimisé pour les applications de grande échelle spatiale avec des résolutions d'images pouvant être faible. On calcule la corrélation entre une fenêtre d'interrogation (IA pour interrogation area) centrée sur un point \( a_i \) dans une image et la même IA centrée sur un point \( b_i \) dans l'image suivante, images séparées par un intervalle de temps de \( \Delta t \) secondes. La taille de la fenêtre d'interrogation est paramétrable dans Fudaa-LSPIV. Le coefficient de corrélation \( R(a_i, b_i) \) est calculé ainsi:
\[ R(a_{ij}, b_{ij}) = \frac{\sum_{i=1}^{M_i} \sum_{j=1}^{M_j} [(A_{ij} - \overline{A}_{ij})(B_{ij} - \overline{B}_{ij})]}{\left[ \sum_{i=1}^{M_i} \sum_{j=1}^{M_j} (A_{ij} - \overline{A}_{ij})^2 \sum_{i=1}^{M_i} \sum_{j=1}^{M_j} (B_{ij} - \overline{B}_{ij})^2 \right]^{1/2}} \]

où \( M_i \) et \( M_j \) sont les tailles de la fenêtre d’interrogation (en pixel) et \( A_{ij} \) et \( B_{ij} \) sont les distributions des intensités des pixels dans les deux fenêtres d’interrogation. Ce calcul n’est effectué que pour des points \( b_{ij} \) inclus dans une fenêtre de recherche (SA pour Searching Area) définie par l’utilisateur, permettant d’économiser du temps de calcul. On suppose que le déplacement le plus probable de l’écoulement à partir du point \( a_{ij} \) pendant le temps \( \Delta t \) est celui correspondant au maximum de corrélation, avec possibilité de définir une corrélation minimale requise.

La précision du calcul étant au pixel prés, il est intéressant de réaliser une interpolation sub-pixel. Soit \( b_{ij} \) la position du maximum de corrélation. Dans Fudaa-LSPIV, un ajustement d’une loi Gaussienne unidimensionnelle est utilisé sur les axes \( i \) et \( j \) pour obtenir une précision de déplacement de l’ordre de 0,2 pixels sous la forme :

\[
\Delta i = \frac{\ln(b_{i+1,j}) - \ln(b_{i-1,j})}{2[\ln(b_{i,j}) - 2\ln(b_{i,j}) + \ln(b_{i,j})]} \quad \text{et} \quad \Delta j = \frac{\ln(b_{i,j+1}) - \ln(b_{i,j-1})}{2[\ln(b_{i,j}) - 2\ln(b_{i,j}) + \ln(b_{i,j})]}.
\]

La position sub-pixel du maximum de corrélation est donc calculée comme \( b_{i+\Delta i,j+\Delta j} \).

Les vitesses de surface sont calculées à partir des déplacements \( b_{i+\Delta_i,j+\Delta_j} - a_{ij} \) divisés par \( \Delta t \). Le calcul est reproduit de manière itérative sur toute l’image pour chaque nœud de la grille de calcul. On calcule ainsi un champ de vitesse 2D de surface, "instantané" (entre deux images successives).


Enfin, Fudaa-LSPIV permet de moyennner les champs de vitesses instantanées filtrées pour calculer un champ de vitesses moyennées sur la durée de la séquence d’images.
Principles of discharge calculation

Knowing the bathymetric profile of at least one cross-section included in the analysis area, Fudaa-LSPIV can calculate the discharge passing through this section. The bathymetric transect can be interpolated at a user-defined pitch, and a surface velocity is calculated for each step from the nearest LSPIV velocities (distance weighted). The user also defines a coefficient connecting the surface velocity to the averaged velocity over the depth for each calculation step. The discharge is then calculated by the method of the median section, the interpolation of the velocities towards the edges being done according to the hypothesis of the number of Froude varying linearly towards zero at the edge.

Definition and interpolation of the bathymetric profile
The bottom points must be ordered from the left bank to the right bank. The transect must contain at least one point whose rating is less than that of the water and the points at the ends must have a higher rating than that of the water. It is possible to have points above the water level (islands) framed by water areas.

Orthogonal projection on the line defined by the extreme points of the transect (first and last point).

Linear interpolation by adding points (from the left bank) whenever the specified maximum space step is exceeded.

Estimated average velocity at each point of the transect
For each transect, the user defines a search radius. In this neighborhood around each node, the maximum 3 closest velocity results are searched. If at least one result is found, then the average velocity on vertical $V_i$ at node $i$ is computed as the average of neighboring velocities weighted by the inverse of distances, multiplied by the user specified surface coefficient $\alpha$ for transect considered:

$$V_i = \alpha \sum_{j=1}^{N_i} \frac{v_{(i, j)}}{d_{(i, j)}}$$

With $N_i$ the number of velocity results $v_{(i, j)}$ found in the neighborhood of the node $i$ of the transect ($N_i \leq 3$); the distance $d_{(i, j)}$ is that between the position $(x_j, y_j)$ of the grid node of the velocity result $v_{(i, j)}$ and the position $(x_i, y_i)$ of the node $i$ with a safety distance fixed to 1 mm:

$$d_{(i, j)} = \max [0.001; (x_j - x_i)^2 + (y_j - y_i)^2]$$

When no LSPIV velocity result is found in the neighborhood of a transect node, the average transect normal velocity is reconstructed by linear interpolation of local Froude numbers between the two nearest nodes, right and left. Indeed, in order to optimize the depth measurement performed on the bathymetric vertical, it is interesting to use a hydraulic hypothesis of linear evolution of the local Froude number, instead of simply correcting the surfaces of the wet subsections, or to interpolate the velocities linearly. The linear interpolation of local Froude numbers is proposed by several references: Boiten (2000), Despax (2016), Fulford and Sauer (1986), ISO / TR 9823 (1990), Le Coz et al. (2008, 2012, 2014).

Either a bathymetric vertical positioned at abscissa $x_i$, whose full verticals (with depth and velocities) closest to each side are positioned at $x_{i-1}$ and $x_{i+1}$ (Figure 1). In $i-1$, the full vertical allows to have the depth $h_{i-1}$ and the average velocity on the depth $V_{i-1}$. The number of local Froude is calculated:

$$\left[ Fr \right]_{(i-1)} = \frac{V_{(i-1)}}{\sqrt{g \cdot h_{(i-1)}}}$$

with $g$ the acceleration of gravity on the surface of the Earth (9.81 m · s⁻²).

In $i+1$, the local Froude number is:

$$\left[ Fr \right]_{(i+1)} = \frac{V_{(i+1)}}{\sqrt{g \cdot h_{(i+1)}}}$$

The Froude number of the bathymetric vertical, positioned in $i$, is calculated by linear interpolation as:

$$\left[ Fr \right]_{(i)} = \left[ Fr \right]_{(i+1)} - \frac{\left[ Fr \right]_{(i-1)} - \left[ Fr \right]_{(i+1)}}{\left[ x_{(i+1)} - x_{(i-1)} \right]} \cdot \left[ Fr \right]_{(i-1)} + \left( x_{(i+1)} - x_{(i-1)} \right) \cdot \left[ Fr \right]_{(i+1)}$$

Knowing the depth in $i$, $h_i$, we calculate the associated average velocity as:
\[ V_i = \left[ Fr \right]_i \cdot \sqrt{g \cdot h_i} \]

Figure 1: Calculation of the average velocity associated with a bathymetric vertical by interpolation of the number of Froude local Fri

In the case of a bathymetric vertical located between the shore and the other verticals, it is advisable to make an assumption about the velocity at the bank: it is theoretically null, but a constant extrapolation or a fictitious shoreline velocity calculated with a coefficient of bank (case of the Bareme software) may be more realistic than a linear extrapolation to zero, in practice. The calculation of the discharge can finally be done normally on all the verticals, now all provided with an estimated average velocity.

Calculation of the discharge through each transect
Median velocity, normal velocity at transect
Edge discharges?
Measured discharge rate / extrapolated

Principes du calcul de débit
Connaissant le profil bathymétrique d’au moins une section en travers incluse dans la zone d’analyse, Fudaa-LSPIV peut calculer le débit transitant par cette section. Le transect bathymétrique peut être interpolé à un pas défini par l’utilisateur, et une vitesse de surface est calculée pour chaque pas à partir des vitesses LSPIV les plus proches (pondération en fonction de l’éloignement). L’utilisateur définit également un coefficient reliant la vitesse de surface à la vitesse moyennée sur la profondeur pour chaque pas de calcul. Le débit est alors calculé par la méthode de la section médiane, l’interpolation des vitesses vers les bords se faisant selon l’hypothèse du nombre de Froude variant linéairement vers zéro au bord.

Définition et interpolation du profil bathymétrique
Les points du fond doivent être ordonnés depuis la rive gauche jusqu’à la rive droite.

Le transect doit contenir au moins un point dont la cote est inférieure à celle de l’eau et les points aux extrémités doivent avoir une cote supérieure à celle de l’eau. Il est possible d’avoir des points situés au-dessus du niveau d’eau (îles) encadrés par des zones en eau.

Projection orthogonale sur la droite définie par les points extrêmes du transect (premier et dernier point).

Interpolation linéaire en ajoutant des points (depuis la rive gauche) chaque fois que le pas d’espace maximum spécifié est dépassé.

Estimation de la vitesse moyenne en chaque point du transect
Pour chaque transect, l’utilisateur définit un rayon de recherche. Dans ce voisinage autour de chaque nœud, les au maximum 3 résultats de vitesse les plus proches sont recherchés. Si au moins un résultat est trouvé, alors la vitesse moyenne sur la verticale \( V_i \) au nœud \( i \) est calculée comme la moyenne des vitesses voisines pondérée par l’inverse des distances, multipliée par le coefficient de surface \( \alpha \) spécifié par l’utilisateur pour le transect considéré :
\[ V_i = \alpha \sum_{j=1}^{N_i} \frac{v_{i,j}}{d_{i,j}} / \sum_{j=1}^{N_i} \frac{1}{d_{i,j}} \]

Avec \( N_i \) le nombre de résultats de vitesse \( v_{i,j} \) trouvés au voisinage du nœud \( i \) du transect (\( N_i \leq 3 \)) ; la distance \( d_{i,j} \) est celle entre la position \((x_j, y_j)\) du nœud de grille du résultat de vitesse \( v_{i,j} \) et la position \((x_i, y_i)\) du nœud \( i \) avec une distance de sécurité fixée à 1 mm :

\[ d_{i,j} = \max[0.001; (x_j - x_i)^2 + (y_j - y_i)^2] \]


Soit une verticale bathymétrique positionnée à l’abscisse \( x_i \), dont les verticales complètes (avec profondeur et vitesses) les plus proches de chaque côté sont positionnées en \( x_{i-1} \) et \( x_{i+1} \) (Figure 1).

En \( i-1 \), la verticale complète permet d’avoir la profondeur \( h_{i-1} \) ainsi que la vitesse moyenne sur la profondeur \( V_{i-1} \). On calcule le nombre de Froude local :

\[ Fr_{i-1} = \frac{v_{i-1}}{\sqrt{g \cdot h_{i-1}}} \]

avec \( g \) l’accélération de la pesanteur à la surface de la Terre (9,81 m·s\(^{-2}\)).

En \( i+1 \), le nombre de Froude local vaut :

\[ Fr_{i+1} = \frac{v_{i+1}}{\sqrt{g \cdot h_{i+1}}} \]

Le nombre de Froude de la verticale bathymétrique, positionnée en \( i \), est calculé par interpolation linéaire comme :

\[ Fr_i = \frac{[(x_{i+1} - x_i) \cdot Fr_{i-1} + (x_i - x_{i-1}) \cdot Fr_{i+1}]}{x_{i+1} - x_{i-1}} \]

Connaissant la profondeur en \( i \), \( h_i \), on calcule la vitesse moyenne associée comme :

\[ V_i = Fr_i \cdot \sqrt{g \cdot h_i} \]
Figure 1 : Calcul de la vitesse moyenne associée à une verticale bathymétrique par interpolation du nombre de Froude local \( Fr_i \)

Dans le cas d’une verticale bathymétrique située entre la rive et les autres verticales, il convient de faire une hypothèse sur la vitesse en rive : elle est théoriquement nulle, mais une extrapolation constante ou vers une vitesse fictive en rive calculée avec un coefficient de rive (cas du logiciel Barème) peut être plus réaliste qu’une extrapolation linéaire vers zéro, en pratique.

Le calcul du débit peut finalement se faire normalement sur l’ensemble des verticales, désormais toutes munies d’une vitesse moyenne estimée.

**Calcul du débit à travers chaque transect**

_Vitesse médiane, vitesse normale au transect_

_Débits de bords ?_

_Taux débit mesuré / extrapolé_
14. References


Theule, J.I., Crema, S., Marchi, L., Cavalli, M., Comiti, F. (2018) Exploiting LSPIV to assess debris-discharge velocities in the field, Natural Hazards and Earth System Sciences, 18(1), 1-13